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               Information Note: Getting started  

“Configurability enables flexibility and 

differentiation” 

by  Holding or their respective owers.  

    

1. Introduction   
  
This Getting started guide covers the following topics to help you start using software:   

•The TCI system  

•The TCI software  

•Working with the USB2DALI interface  

•Working with NFC interfaces  

 

  

For detailed information, consult the TCI Workflow User manual.   
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3. TCI Software system   
  

With our software, you can configure all features that are supported by a specific TCI. A feature typically belongs 

to one or two device families, but this does not mean that every device from a device family does support all 

features.  

TCI software only works in combination with the 127105 USB2DALI interface and 127095A or 127101 NFC 

interface.   

  

3.1 USB2DALI interface   

The TCI system for DALI devices consists of the following components:   

• 127105 USB2DALI interface, the interface between the PC and the DALI devices.  

  

 
 

 

 

  

• USB cable, to connect the PC with the USB2DALI interface.  

  

    or   

  

  

  

  

  

  

• TCI software, to be installed on the PC or laptop.  

See next chapter.  

• DALI is supported by TCI Engineering and by TCI Workflow  

  

  

    
3.2 USB2ZigBee interface  
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The TCI system for ZigBee devices consists of the following components:   

•LCN8650 USB2ZigBee interface, the interface between the PC and the ZigBee devices.  

  

  

• TCI software, to be installed on the PC or laptop.  

See next chapter.  

•ZigBee is supported by TCI Engineering and  by TCI Workflow  
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3.3 USB22 NFC interface  

The TCI system for NFC devices consists of the following components:   

•127095A, 127101 NFC interface are USB devices which interface between the PC and NFC devices  

  

                 127095A                                                                        127101                                                            

 
  

•USB-A to USB-B cable to connect the PC with the NFC interface.  

•TCI software, to be installed on the PC or laptop. See next chapter.  

• NFC is supported by TCI Engineering and by TCI Workflow  

  

3.4 Art-Net   

•The TCI system for Art-Net does not require specific components. For example, TCI software  works with 

drivers connected to via a Luminex controller.  

• TCI software, to be installed on the PC or laptop.   

See next chapter.  

•Art-Net is supported by TCI Engineering and not by TCI Workflow  

  

    

4. TCI software   
  

4.1 Download   

TCI software can be downloaded directly on our website https://www.tci.it/ 

 

This zip-file contains the following files:  •The TCI software installation file  

•The TCI Workflow installation file  

•The Getting started document  

•The User manual  

•The readme file  

  

4.2 Minimum system requirements   

Before installing, make sure the PC or laptop complies with the minimum system requirements for using the 

software:   

•PC or laptop with Microsoft Windows 8, 8.1,10 and 11.  

•One or multiple USB 2.0 port(s):  

- Two free USB 2.0 ports for use with USB2DALI interface  

- One free USB 2.0 port for use with USB2ZigBee interface  

- One free USB 2.0 port for use with NFC interface  

•Ethernet port:  

- One free Ethernet port for use with Art-Net protocol  
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•At least 45 MB of free disk space  

•Microsoft .NET Framework 4.6.1 (download here for offline installation)  

  

4.3 Installing   

The software installation file is the installer for the full version of TCI software. The TCI Workflow installation file 

is the version of software which is meant to be used in a production environment.   

  

To install the software, launch the installer for the desired version and follow the instructions on your screen. 

NOTE: Make sure that all interfaces are disconnected before installing.   

  

The installation wizard will guide you through the process of installing the software and will ask you where the 

software needs to be installed. At the end, it will give you the option to immediately start the software.   

  

    
4.4 Activation   

TCI Engineering will ask you to activate your copy of software upon the first startup.   

  

  

  

  

Press the Activate button and follow the onscreen information in order to activate your TCI Engineering copy.   

  

Then the user software key details and supported features should contain the expected information. After 

pressing the close button software is ready for use.   
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5. Working with the 127105 USB2DALI interface  
  

5.1 Connecting the USB2DALI interface   

Before launching, make sure the USB2DALI interface is connected. First connect both USB plugs (USB-A) of 

the provided cable into your PC’s USB ports.  When only one USB port is available, connect the black USB 

plug.   

   

  

   or   

  

  

  

  

  

  

  

  

                                                                2 x USB-A plug   

  

  

Second, connect the other end of the cable (mini-USB) to the USB2DALI interface.   

  

  

  or   

  

  

  

  

  

  

  

  

   

                                                                  mini- USB plug  

  

  

Connect the USB2DALI interface to a (network of) DALI device(s), using the double DALI connectors (WAGO 250 

connectors). The double DALI connectors allow a wiring scheme in which the USB2DALI interface is wired in a 

sequence together with other DALI devices (daisy chain).   
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                Status LEDs                                           Double DALI connectors  

  

Finally make sure the DALI devices are connected to the mains.   

  

The status LEDs have the following meaning:   

Green led: is on when the USB2DALI interface is powered.   

Red led: is on when the DALI power supply is on.   

Orange led: blinks when there is DALI communication.   

  

When software is started you need to make sure the USB2DALI interface is used. This can be done by going to 

the Tools => Connection settings….  

  

  
  

In the pop-up window select DALI; select the port to which you connected the USB2DALI interface and click OK.   

  

Notice! The unique id of the interface is shown at the port selection. This, to be able to identify which interface is 

used by which software instance (when configuring devices in parallel using multiple instances of software).   
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5.2 Scanning and commissioning a DALI network   

When starting the software, the connected DALI devices to the USB2DALI interface are not automatically 

identified. There are two buttons in the Network tab on the left-hand side of the application window: Scan 

network and Commission.   

•Scan network: all devices are scanned for their short addresses. This procedure does not change any 

short addresses or other properties of the connected devices. In order to identify a device, a short 

address is needed; devices without a short address are being assigned with one. When two or more 

devices have the same short address, a warning is given.  

•Commission: all devices are given a new short address, starting at 0. Be aware that existing short 

addresses are erased and new short addresses are re-assigned to all devices connected. This procedure 

ensures that all devices have a short address and that there are no duplicate short addresses.  

 

After commissioning or scanning the network, the list of identified devices is shown in the Network tab.   

 
5.3 Selecting devices for communication   

After having commissioned or scanned the network, the Network tab shows all devices present in the DALI 

network. By clicking on a device you will make that particular device the active one, meaning that all commands 

will be sent to this device only, and will be ignored by all other devices.   

  

Besides selecting a single device for communication, it is also possible to communicate with multiple devices. The 

options are:   

•Select All devices. All commands will now be sent as broadcast commands. Note that unidentified DALI 

devices will also respond to commands.  

•Select User-defined groups. All commands will now be sent to devices that belong to a user-defined 

group.  

•Expand or create User-defined groups and select the desired user-defined group. All commands will 

now be sent to devices that belong to this specific user-defined group.  
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5.3.1 DALI groups   

When all the drivers in the DALI network are known, it is possible to work with DALI groups. Select the Groups 

tab and press Scan groups. After having scanned the network, the Groups tab shows all the DALI groups and the 

found devices for every group.   

  
By clicking on a device you will make that particular device the active one, meaning that all actions will be 

performed on this device only, and will be ignored by all other devices. Besides selecting a single device for 

communication, it is also possible to communicate with a group of devices. Select Group n. All commands will 

now be sent to devices that belong to this specific DALI group.   

  

6. Working with the LCN8650 USB2ZigBee interface  
  

6.1 Connecting the USB2ZigBee interface   

Before launching make sure the USB2ZigBee interface is connected and make sure the ZigBee devices are 

connected to the mains.   

  

When software is started you need to make sure the USB2ZigBee interface is used. This can be done by going to 

the Tools => Connection settings….  

 

 

 

 

 

  

In the pop-up window select ZigBee; select the port to which you connected the USB2ZigBee interface and click 

OK.   
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6.2 Scanning a ZigBee area   

After selecting the USB2ZigBee interface, the ZigBee devices and networks in the area of the interface are not 

automatically known.   

 

 

  

To find the devices and networks in the area press Scan area: the area is scanned for all devices and networks 

which are in range. After scanning the area, the found devices and networks are shown in the Network tab.   

  
6.3 Selecting devices for communication   

After having scanned the area, the Network tab shows all devices and networks in range 

of the USB2ZigBee interface.   

  

  

  

  

  

By clicking on a device or network you 

will make that particular device or 

network the active one, meaning that 

all actions will be performed on 

this device or network only, and will 

be ignored by all other devices or 

networks.   

  

Once you have scanned the area and found 

devices and networks in range, it is possible to 

scan a specific network for zones. Select the 

Zones tab, select a Network and press 

Scan zones. After having scanned the network, 

the Zones tab shows the found devices and 

zones within the specified network.   

  

By clicking on a device or zone you will make 

that particular device or zone the active one, 

meaning that all actions will be performed on 

this device or zone only, and will be ignored by all other devices and zones.   

For detailed information on devices, networks and zones, please be referred to the TCI software User manual.   
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7. Working with the NFC interface(s)   
  

7.1 Connecting the NFC interface   

Before launching, make sure the NFC interface is connected.   

  

NOTE: If a device is to be powered during configuring, make sure it is connected to the mains ground. Without 

the ground connection, reliable communication may not be achieved.   

  

When software is started you need to make sure the NFC interface is used. This can be done by going to the 

Tools => Connection settings….  

  
  

In the pop-up window select NFC, select the interface, select the reader (in case of a FEIG interface) and click OK.   

  

Notice! The unique id of the interface is shown at the reader selection. This, to be able to identify which interface 

is used by which software instance (when configuring devices in parallel using multiple instances of software).   

  

7.2 Scanning a NFC device   

After selecting the NFC interface, a NFC device near the interface is not automatically known by software.   

  
  

To get the device press Scan for device; touch and hold the NFC interface close to the device until the scan 

has completed, if needed, a pop-up will appear indicating the device and the NFC interface must touch. The 

scanned device will be shown in the Network panel.   

  

 

 

 

 

  



13 | P a g e  

  

13 

 

7.3 Selecting devices for communication   

  

After having scanned the NFC device, the Network tab shows the device.   

  

  
By clicking on a device you will make that particular device the active one, meaning that all actions will be 

performed on this device and will be ignored by all other devices.   

  

7.3.1 Auto read   

After a device gets selected all features are shown on the Features tab and auto read gets activated. Auto read 

automatically start reading the configuration of all features. Progress is shown.   

  

Note! If the NFC interface is not close to the device, Auto read will not work.   

  

     



14 | P a g e  

  

14 

 

8. Working with Art-Net   
First select the protocol: Art-Net.  

e Art-Net protocol the delay time between sending frames is shown in the dialog. This delay time is set to 28ms 

and cannot be changed.     

9. Disconnected interface   
  

If the USB2DALI, or NFC interface becomes disconnected during use, software must be restarted. After closing 

software reconnect the interface via its USB plug. Restart and, as before, scan the device/network and resume 

communication.   
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10. Configuring device features   
  

In the main application window, click the Device features tab.   

  

  
  

The content of this tab depends on the device that has been selected in the Network tab. If a device does not 

support any feature, a message will be displayed. If a group of devices is selected, no features will be shown 

since it is not possible to configure features for multiple devices at once1.   

  

Upon selecting a device in the Network tab, the Device features tab displays the features that are supported by 

this device. After selecting another device, the Device features tab is updated to show only the features 

supported by the newly selected device. You will have to click the Read button to see the exact configuration, 

except when using the NFC interface. See 7.3.1.   

  

Use the various graphs, sliders and input boxes to configure the various feature parameters. For detailed 

information on device features, please be referred to TCI User manual.   

  

10.1 Reading and writing device features   

The Device features tab can do three things: show the default values used by software, display the feature 

configuration currently stored in a device and write a new feature configuration to the device.   

To display the current feature configuration stored in a device, select the device in the Network tab. The device 

features of the selected device are shown at the Device features tab. Click the Read button in the toolbar.   

  
  

A dialog window pops up in which you can make a selection of device features to be read. Make a selection and 

click Read. After a few seconds the current feature configuration is shown on the Device features tab. 

 

 

 

 

 

 

 

 

 

 

 
1 To configure device features for multiple devices you can use virtual devices. Please be referred to the TCI User manual for 

details.   
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 The feature configuration can now be adjusted manually.   

  

After adjusting the values, click the Write button in the toolbar.   

  
  

A dialog window pops up in which you can make a selection of device features to be written. Make a selection 

and click Write. After a few seconds the status bar will indicate that the data was successfully written.   

  

To save the current feature configuration to a file, click the Save icon on the toolbar or select File => Save as.   

  

  
Enter a file name and a location and click Save.   

  


